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End-User License Agreement 
MED2020 proprietary rights are included in the information disclosed in this manual.  

Permission to reprint this document is provided to facilities and users of licensed WinRecs products, 
provided that the document is complete and its contents remain unaltered. No proof of status is 
required. 

Neither this document nor the information disclosed herein, or any part thereof, shall be transferred to 
other documents, used by, or disclosed to other parties for any purpose except as explicitly authorized 
by MED2020 Health Care Software Inc.  

Please note that MED2020 Health Care Software Inc. cannot give permission for use of any third‐party 
content. 

 

Microsoft, Windows, Windows server, Microsoft SQL Server 2000, Microsoft SQL Server 2005 and 
Microsoft SQL Server 2005 Express are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. 

Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation. 

Crystal and Crystal Reports are registered trademarks of Business Objects SA. 

Other trademarks remain the property of their respective owners. 
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Contact MED2020 
Should you have any questions regarding the content of this manual, please do not hesitate to contact 
MED2020 Client Services with the contact information below: 

 
2025 Lanthier Drive 
Orleans, Ontario 
K4A 3V3 
  
Tel:    (613) 830‐3761 
Toll Free:    (800) 461‐2020 
Fax:    (613) 830‐5992 
   
Email:    support@med2020.ca 
Web:    http://www.med2020.ca 
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About This Document 
The information contained in this document focuses on the installation and maintenance of the 
MED2020 WinRecs suite of applications. 

To learn more about using WinRecs please refer to the WinRecs User Guide, also available as a 
download from the MED2020 Client site, located at ftp://web.med2020.ca. 

Document Conventions 
Throughout this User Guide, text formatting is used to complement the information provided. 

Function keys and key sequences are distinguished by large bold text.  

Example:  CTRL+M 

 

References to modules, functions and other values as displayed on the screen are distinguished by italic 
text. 

Example:   WinRecs Application Menu 
 

File names, paths and cross‐references to other sections of the User Guide are distinguished by bold 
text. 

Example:   Introduction to the CPI Layout 

Example:   C:\temp\test.txt 
 

Values to be typed are distinguished by the courier font. 

Example:   Type 01011920 in the field. 
  

Important notes and hints are distinguished by text with a gray background.  

Example:  NOTE: This is an important 
note 

 
Throughout this document, the WinRecs installation path is assumed to be C:\Program Files\WinRecs 2.  
If your site changed the path, please adjust the steps in this guide to suit your site’s installation path. 
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Introduction 
READ THIS SECTION BEFORE INSTALLING ANY SOFTWARE 

This document was written for a moderately technical audience.  This document assumes that the user 
shall understand fundamental concepts with respect to file, computer, server and network administration.  
This document will detail the proper procedures for installing a database server specific to a WinRecs 
installation.  Administering computers, servers or networks other than instructions contained in this guide 
are outside the scope of this document and MED2020’s support services.  If the user is not familiar with 
basic computer, server and network administration, the user should seek professional assistance with the 
installation of a WinRecs database server, as MED2020 cannot be liable for catastrophic data loss.  
MED2020 does not undertake data backup or data recovery services under your site’s standard support 
contract. 

The information contained in this document is provided to assist with the WinRecs installation and post-
installation server activities, such as basic database maintenance. Instructions are provided for Microsoft 
SQL Server 2000, Microsoft SQL Server MSDE, Microsoft SQL Server 2005 and Microsoft SQL Server 
2005 Express environment.  The version of the database software installed at your facility will determine 
which procedures are used when performing the database maintenance activities. 

Microsoft SQL Server 2000 or Microsoft SQL Server 2005 are the commercial database server software 
packages, generally used by facilities with larger data repositories or those who must support a large 
number of simultaneous connections.  

Enterprise Manager is installed when installing Microsoft SQL Server 2000.  This administrative tool is 
rather extensive and for the purposes of this document, references to Enterprise Manager are limited to 
the tasks necessary to attach and detach WinRecs databases. 

For facilities with limited data or computing requirements, the Microsoft SQL Server MSDE (2000) or 
Microsoft SQL Server 2005 Express can be used.  This free database software, also provided by 
Microsoft, provides limited data storage and is ideal for smaller WinRecs installations.  However, this 
version of the database software does not provide additional support applications such as the Enterprise 
Manager.  If your environment has an installation of Enterprise Manager, you might be able to use it to 
connect to, and administer, your MSDE database(s) and/or server(s).  This document assumes that 
Enterprise Manager is installed on the WinRecs database server. 

In the event that your facility is not able to use the Enterprise Manager, MED2020 provides custom 
utilities that can be used to attach and detach your WinRecs databases.  These custom utilities will be 
referenced in the relevant sections of this manual. 

Alternatively, instructions are provided for using OSQL, a command-line application installed with both the 
commercial and free versions of the database server software that can be used to perform queries, 
updates and maintenance, such as attaching databases and performing backups.  

For more information on maintaining Microsoft SQL Server database applications, it is recommended that 
you consult the Microsoft support web site or your product documentation. 

Contact MED2020 Client Services for more assistance with any information contained in this document.  
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Technical Requirements 
Acceptable server specifications are identified on a per‐client basis. The following specifications are only 
used to provide a baseline for typical implementations. 

Minimum Server Specifications for SQL 2000/2005 
 
Pentium IV 2.4 GHz 
2 GB RAM 
20 GB hard disk for WinRecs Installation1 
100 Mbps Network connections 
Microsoft SQL Server 2000 (Standard/Enterprise or MSDE with latest service packs applied)2 

Microsoft SQL Server 2005 (Standard/Enterprise or Express with latest service packs applied)2 
Windows 2000 Server, Windows 2003 Server with latest service packs applied  
Internet access 

NOTE: (1) The 20 GB hard disk required for the WinRecs installation must be a separate physical drive. 

  (2) Sites with less than 250,000 abstracts with a maximum of five client workstations can use the 
free version of Microsoft SQL Server 2000 MSDE or Microsoft SQL Server 2005 express. 

 (3) Sites operating under Windows Server 2008 must use SQL 2005 

 (4) Windows Server 2008 is not officially supported by MED2020 at this time. 

Minimum Workstation Specifications 
Pentium IV 2.0 GHz 
256 MB RAM 
2 MB video card (800x600 @16‐bit color) 
17‐inch monitor 
Windows 2000, Windows XP Professional with latest service packs applied 
CD‐Rom 
2‐4 GB available disk space 
Internet Access 

Software Requirements 
The installation media provided to your facility contains the files and applications required to install 
WinRecs on your server(s) and full‐client workstations. Alternately, the files can be obtained from the 
MED2020 client FTP site, located at ftp://web.med2020.ca. 
The following components are required to successfully complete the installation of the MED2020 
WinRecs application suite: 
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Windows 2000,  XP 
Professional, Vista 
Business, Vista 
Enterprise, or Vista 
Ultimate1 

A fully licensed version of the Windows Operating system is required for client workstation installations.  The 
operating system must be stable before beginning the installation of the database and WinRecs components.   

Windows Server 2000, 
Windows Server 2003, or 
Windows Server 2008 

A fully licensed version of the Windows Operating system is required for server workstation installations.  The 
operating system must be stable before beginning the installation of the database and WinRecs components.   

 

Microsoft SQL Server 
2000/20051 

Required for the server installation.  The free, scaled‐down alternate version of Microsoft SQL Server 2000 
MSDE is available for download at http://www.microsoft.com/downloads/details.aspx?FamilyID=413744d1‐
a0bc‐479f‐bafa‐e4b278eb9147&DisplayLang=en. Microsoft SQL Server 2005 Express is available for download 
at http://www.microsoft.com/downloads/details.aspx?familyid=220549b5‐0b07‐4448‐8848‐
dcc397514b41&displaylang=en. 

WinRecs Database 
MED2020 WinRecs/SQL database files. Unzip utility required (not supplied) to extract the database files from 
the archive (MED2020_Data.MDF and MED2020_Log.LDF). 

MEDSQL2.EXE 
Utility used to attach the WinRecs Database files and create the required WinRecs system account. For SQL 
2000 MSDE, we must use this utility. 

MEDSQL4.EXE 
Utility used to attach the WinRecs Database files and create the required WinRecs system account.  Required 
for SQL 2005 Express.  Not for use with SQL 2000 MDSE  

WR_MSDE.ini 

(For MSDE installation 
only) 

Options configuration file that can be used to automate the installation of Microsoft SQL Server 2000 MSDE.   
When used, Microsoft SQL Server 2000 MSDE will be installed in C:\MSSQL with the following options: 

‐ Network connections enabled 

‐ Mixed Mode authentication 

‐ Preset SA Password 

NOTE:  To change the SA password prior to installation, edit the corresponding field in WR_MSDE.ini. 

INSTALL_MSDE.CMD 

(For MSDE installation 
only) 

Used in conjunction with WR_MSDE.ini to perform an automated installation of Microsoft SQL Server 2000 
MSDE. 

Securitychange.exe  Used to correct the security settings of the SQL Server installation.

License Key 
Please ensure you have your License Key.  If you do have this call MED2020 during normal business hours to 
obtain it. 

 

NOTE: (1) Your software license with MED2020 does not provide a commercial version of 
these software products. This is available from MED2020 as a separate license.  
Please contact sales@med2020.ca or call 1.800.461.2020 for more information and a 
quote. 
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Before You Begin… 
 

Prior to beginning installation of WinRecs, please ensure that you have everything you need to 
complete the installation available to you.  This is particularly important with respect to your license key.  
If you do not have this available to you, please contact MED2020 during normal business hours. 
 

Prior to installing any software, please ensure that you have made backup copies of your 
sensitive data.  Also please ensure that you have your backups readily available, and that you know the 
exact path to your databases.  MED2020 cannot be held responsible for data loss, nor can MED2020 
assist with data backup and recovery.  Instructions for backup and recovery are outside the scope of this 
document. 

 
Quick Start (Standalone/BI/HL7) 
The steps below provide an overview of how to successfully install WinRecs.  Each step is described in 
greater detail in the sections to follow. 

1. Install Microsoft SQL Server 2000 the following settings: 

Authentication Mode: Select Mixed mode. Choose a strong SA password. 

Collation Settings: 
Collation Designator: Latin1_General 

Sort Order:  Accent Sensitive 

Network Libraries: 
Enable Named Pipes: \\.\pipe\sql\query 

Enable TCP/IP Sockets:  1433 

2. Extract the .mdf and .ldf files to the new folder, drive or server.   
It is strongly recommended not to use a network share (presented SAN drives can be 
used), nor the same drive on which the operating system is installed.  Doing so will 
adversely affect system performance and stability.  

NOTE:  Do not change the file names of the Database or Transaction Log files. 

3. Attach the WinRecs database using either the MEDSQL2 or MEDSQL4 utility. 
4. Install additional WinRecs components 

a. If a batch interface must be installed: 

i. Attach the Batch Interface (refer to the corresponding section in this document), 

ii. After successfully logging in to the new WinRecs instance, proceed to configure 
the Batch In Module (refer to the custom instructions provided to your facility for 
more information on this process). 

b. If a HL7 interface must be installed: 

i. Install the HL7 Interface application  (refer to the custom instructions provided to 
your facility for more information on this process), 
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ii. Run the HL7_Initialize utility to configure the WRHL7 user name and password 
on the new server. Configure the HL7 Interface to point to the new database(s). 

iii. Configure the TCP/IP address and port information to be used for HL7 
transactions. 

c. Install WinRecs and applicable service packs/patches on the new server.  Contact 
MED2020 to obtain the most recent version, if required. 

d. Create the WR2 Reports folder and shared reporting folders and extract the contents of 
the archives to these folders.  

5. Install WinRecs on client workstations. 

A checklist is provided on the last page of this manual as a guideline to assist with the installation, and 
keep for your records.  This information might be requested when contacting MED2020 Client Services 
for technical assistance. 
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Introduction to SQL Server 2000/2005 
 

Prior to installing any software, please ensure that you have made backup copies of your sensitive data.  
Also please ensure that you have your backups readily available, and that you know the exact path to 
your databases.  MED2020 cannot be held responsible for data loss, nor can MED2020 assist with data 
backup and recovery.  Instructions for backup and recovery are outside the scope of this document. 
 
Prior to installing Microsoft SQL 2000 ensure that you have fully read the following support 
documentation which is provided by Microsoft with the install of SQL Server 2000: 
 
http://support.microsoft.com/support/servicepacks/sql/2000/sp3readme.asp?SD=gn&LN=en‐
us&gssnb=1http://www.microsoft.com/sql/prodinfo/previousversions/system‐requirements.mspx 
Additional documentation, trouble shooting tips and knowledge base articles can be located on the 
Microsoft support website. The use of the information located in this document is specific to installing a 
SQL Server 2000 instance for use with a WinRecs database.  
 

Choosing a version of SQL Server 
 

Before choosing a version of SQL Server to install, it is important to understand the differences and 
limitations of each variation. 
 

SQL Server 2000 MSDE 
SQL 2000 MSDE (Microsoft SQL Desktop Engine) is a reduced functionality version of SQL Server 2000.  It 
was designed primarily as a desktop engine to operate applications that do not require server 
functionality and for users with smaller databases.  As a result of this SQL MSDE 2000 does not make the 
best environment for a WinRecs server. 
 

Pros  Cons 
Absolutely free of charge  Databases are restricted to 2048 MB (2GB) 

in size 
  Not engineered for server use 
  MSDE 2000 is an end of life product, so 

support will be very limited 
  Reduced performance when performing 

more than 5 queries 
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SQL Server 2000 
SQL Server 2000 is a version of SQL Server that was designed to be used for a wide variety of purposes.  
Unlike the MSDE version, it does have a cost attached.  It is worth noting that SQL 2000 is also an end of 
life product, and therefore is not available for purchase any longer. 

Pros  Cons 
Does not have the limitations of MSDE End of life product, limited availability and 

support
  Cost 

 

SQL Server 2005 Express 
SQL Server 2005 Express was designed as the immediate successor to MSDE.  SQL Server 2005 
Express does have limitations, but retains it’s free status. 

 
Pros  Cons 
Absolutely free of charge Databases are limited to 4096 MB (4 GB) in 

size
Less limitations than MSDE Only supports 1 CPU 
Is designed for either a desktop or small 
server 

Only supports 1024 MB (1GB) of RAM 

 

SQL Server 2005  
SQL Server 2005 is Microsoft’s next release of SQL Server.  It is faster, more reliable and more efficient 
than other edition. 

  
Pros  Cons 
No limitations Cost 
Less limitations than MSDE  
Is designed for either a desktop or small 
server 

 

 

 

NOTE:  SQL Server 2000 is an end of life product.  If you do not have license keys for SQL 2000, you will 
need to use SQL 2005 instead.  Contact sales@med2020.ca for more information on SQL Server 
2005 and to obtain a quote. 
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Installing Microsoft SQL Server 2000 
 
Install Microsoft SQL Server 2000 SP3 to a separate physical drive.  This is required to ensure that 
database performance is not adversely affected by the operating system. 
If installing an older version of Microsoft SQL Server 2000, ensure that you update the installation to 
Service Pack 3/3a, using the supplied instructions later in this section. 
Microsoft SQL Server 2000 must also be installed with the following options: 
 
 
Authentication Mode  Select Mixed mode. Choose a strong SA password.

Collation Settings 
Collation Designator: Latin1_General

Sort Order:    Accent Sensitive 

Network Libraries 
Enable Named Pipes: \\.\pipe\sql\query

Enable TCP/IP Sockets:   1433 

 
 
 
Click SQL Server 2000 Components 
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Click Install Database Server 
 

Click Next 
 

 

Select Local Computer and click Next 
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Select Create a new instance of SQL Server, or 
install Client Tools and click Next 
 

 

Type the software licensee information in the 
Name and Company fields and click Next 
 

Click Yes to accept the terms of the license 
agreement  
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Select Server and Client Tools and click Next 
 

Select Default and click Next 
 

 
Select Custom 
Click the Browse button next to Data Files and 
specify the physical or SAN disk where the SQL 
Data Files will be installed 
Click Next 
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Click Next to accept the default components to 
be installed 
 

 

Select Use the same account for each service 
Select Use the Local System account 
Click Next 
 

 

Select Mixed Mode (Windows Authentication 
and SQL Server Authentication) 
Type and confirm the password that will be 
used for the SQL sa account then click Next 
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Select Collation designator and select 
Latin1_General from the drop‐down list 
 
 
Select Accent sensitive as the Sort order.  
Click Next 
 

 

Keep the default settings (Named Pipes; TCP/IP 
sockets, port 1433). 
Click Next 
 

 

NOTE: Latin1_General is mandatory to reduce unnecessary server overhead and improve 
performance and to eliminate conflicts when running database updates, etc.  Please 
ensure that it is NOT SQL Latin1_General. 
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Click Next to copy the program files 
 

 

During the installation, a progress bar is 
displayed 
 

Once the program files have been installed, 
click Finish to complete the setup. 
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Installing Microsoft SQL Server 2000 Service Pack 3a 
 
If required, proceed to install Service Pack 3a for Microsoft SQL Server 2000, which can be obtained 
directly from the Microsoft download site. 
Extract the files from the downloaded executable. 
 
In the extracted files folder, locate and run setup.bat: 
 

 

 

NOTE: File extensions can be displayed by performing the following steps: 

  - From the Tools menu in the explorer window, select Folder Options  

  - Click the View tab 

  - Uncheck Hide file extensions for known file types 

 - Click OK 

 
Click Next 
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Click Yes to accept the terms of the license 
agreement 
 

 

Click Next 
 

 

Select The SQL Server system administrator 
login information (SQL Server authentication) 
Type the SQL sa account password.  Click Next 
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Select Upgrade Microsoft Search and apply SQL 
Server 2000 SP3 (required).  Click Continue 
 
 

 
Leave the box unchecked and Click OK 
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Click Next 
 

 

A progress bar is displayed during the installation 
process 
 

 

You will be advised to back up your master, temp 
and MSDB databases.  
Click OK, then click Finish in the Setup Complete 
window. 
 

 
 

 

 
 
 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 26 of 105 

 
Friday, January 30, 2009 

 

Installing Microsoft SQL Server 2000 MSDE  
Microsoft SQL Server 2000 MSDE is a free database alternative for clients with low usage requirements 
and limited deployments.  SQL Server 2005 is an excellent alternative to MSDE. 

MED2020 has simplified the installation for WinRecs customers by providing an installation script and 
configuration file.   
The settings used when performing an automated installation are: 
Root folder  C:\ MSSQL. 

To install to a different drive, edit the TARGETDIR setting in 
the WR_MSDE.ini file. 

Authentication Mode  Mixed Mode (SQL & Windows Authentication) 
Network Connections  Connections from networked systems enabled. 
Default SA Password  !MED2020WR! 

To change this password, edit the SAPWD in the 
WR_MSDE.ini file. 

Complete the following steps to perform an automated installation of the Microsoft SQL Server 2000 
MSDE: 

• Run MSDE2000A.EXE and select the default path for the extracted files 
(C:\MSDERelA). 

• Copy WR_MSDE.ini and INSTALL_MSCD.cmd to C:\MSDERelA. 
• From C:\MSDERelA, run INSTALL_MSCD.cmd.  A Windows command window will 

be displayed throughout the installation. 
• When the command window  automatically closes, the installation is complete.  It is 

recommended that the system be rebooted to ensure that all applications and 
services start correctly. 

NOTE: Be sure to keep your SQL server installation up to date with the most recent service 
packs.  Consult the Microsoft support site for more information. 

 Post Database Installation 
After installing the SQL Server software, reboot the server or open the Services utility (located in the 
Control Panel‐>Administrative Tools folder) to verify that SQL server is running. 
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Introduction to SQL Server 2005 
 
Prior to installing any software, please ensure that you have made backup copies of your sensitive data.  
Also please ensure that you have your backups readily available, and that you know the exact path to 
your databases.  MED2020 cannot be held responsible for data loss, nor can MED2020 assist with data 
backup and recovery.  Instructions for backup and recovery are outside the scope of this document. 
 
Prior to installing Microsoft SQL 2005 ensure that you have fully read the following support 
documentation which is provided by Microsoft with the install of SQL Server 2005: 
 

1. ReadmeSQL2005.htm 
2. RequirementsSQL2005.htm 

 

Additional documentation, trouble shooting tips and knowledge base articles can be located on the 
Microsoft support website. The use of the information located in this document is specific to installing a 
SQL Server 2005 instance for use with a WinRecs database.  
 
Note: MED2020 strongly recommends that each client workstation have the SQL Server 2005 backwards 
compatibility msi (SQLServer2005_BC.msi) run on it in order to ensure that full functionality with 
WinRecs is enabled. This file is available from Microsoft. The file may also be downloaded from the 
MED2020 FTP Site.  (ftp://web.med2020.ca/SQLServer2005_BC.msi) The process for pushing this file 
out by a network administrator is outside of the scope of this document. 
 

Installation Procedures 
Pre‐install of Support Files and System Configuration Check 
 

1. Insert CD and locate the setup.exe for the Microsoft SQL Server 2005 Standard install. 
2. Initiate the install by double clicking on the setup.exe. 

 
Prior to Microsoft SQL Server 2005 being installed the following are installed by the setup program: 

1. Microsoft SQL Native Client (if not already installed) 
2. Microsoft SQL Server Setup Support Files 

 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 28 of 105 

 
Friday, January 30, 2009 

 
System Configuration Check 
 
The next step in the installation procedure is a System Configuration Check which ensures the computer 
is ready to have Microsoft SQL Server 2005 installed. Once each of the fourteen checks has successfully 
run, click on Next and continue with the install. If any of the checks are not successful, exit out of the 
install and resolve the issues which the configuration check identified. Once the issues are fixed, restart 
the install.  
 

After ensuring that the server has passed the System Configuration Check, proceed with the install of 
Microsoft SQL Server 2005.  

 

 

Click Next 
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Installing Microsoft SQL Server 2005 

1. Enter a Name for the Microsoft SQL Server 2005, and the license string as provided by 
Microsoft. Entering the company name is optional. 
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2. At the ‘Components to Install’ screen check the ‘SQL Server Database Services’ checkbox. It 
is optional to check the ‘Integration Services’ and ‘Workstation components’ checkbox. 

 

3. Click Next. 
 

4. At the ‘Instance Name’ choose the ‘Default instance’ radio button. 
5. Click Next.  
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NOTE:  For WinRecs to function correctly, ensure that you choose default instance. 

 

6. At the ‘Service Account’ screen choose the ‘Use the built-in System Account’ radio button. 
7. From the drop down list ensure that ‘Network Service’ is chosen 
8. Choose the ‘SQL Server’ and ‘SQL Browser’ check boxes. 
9. Click Next 
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10. At the “Authentication Mode” screen choose the ‘Mixed Mode’ radio button.  
11. Enter a password for the sa user. Note this password. 
12. Click Next 

 

NOTE:  WinRecs requires a Mixed Mode environment to function correctly. 

 

13. At the ‘Collation Settings’ screen choose the ‘Collation designator and sort order’ radio 
button. 

14. From the drop down list choose ‘Latin1_General’ 
15. Ensure the ‘Accent – sensitive’ checkbox is checked and the other checkboxes are not 

checked. 
16. Click Next 
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IMPORTANT NOTE:  It is imperative that Latin1_General is selected; do not use SQL 
Latin1_General, as performance will be severely degraded.  Accent Sensitive must be 
selected. 

 
 The next screen is the ‘Error and Usage Report Settings’ screen. Setting up these features is beyond the 
scope of this document. Refer to the Microsoft documentation for information regarding using these 
options. 
 
 
 
 
 
 

17. On the ‘Ready to Install’ screen ensure that you have chosen the components you need to 
install and then proceed with the install. 
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18. Once the set up is complete click on the Next button. 
 

 

Post Install 

1. After install is complete click on the Surface Area Configuration link on the final screen.  
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2. When the Surface Area Configuration utility launches choose the Surface Area Configuration for 
Services and Connections link.  

 

3. Expand the Database Engine Node 
4. Click on Remote Connections.  
5. Choose the ‘Using both TCP/IP and Named Pipes’ radio button. 
6. Apply your changes and exit out of the Surface Area Configuration Utility.  
 

 

7. Click Finish on the final install screen.  
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8. Reboot the server.  
9. After the server has rebooted ensure that the SQL Server Browser Service is running. 

 
Windows Firewall Configuration 
 
In order for the WinRecs Client as well as SQL Server to talk with one another they need to communicate 
over specific ports which need to be opened up within the Windows Firewall. 
 

1. From the control panel open up the Windows Firewall  
2. Choose the exceptions tab 
3. Create entries for the following ports – both TCP and UDP 

1433 
1434 
53 
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Attaching your WinRecs Database 
 

Med2020 Software will supply you with a utility which will attach your WinRecs database to Microsoft 
SQL Server for you. Utility name is Medsql4.exe.  This file can be obtained on the MED2020 FTP Site 
(ftp://web.med2020.ca).  In doing so, all the security roles and permissions required will be configured 
for you.  

 
1. Create folder to hold the database. MED2020 recommends that the SQL2005 server installation 

is finished before the folder is created.  
2. Copy the WinRecs database to this folder.  
3. Launch Medsql4.exe. 
4. In the Environment box type in the name of the database as you want it to appear. 
5. Choose the (local) option in the server drop down box. If you select to use the named 

instance(see Page 8), the server name will have slash(like “<Local Computer Name>\<Server 
Name>”). If you can’t find the server name from the drop down list, you can type in the correct 
SQL2005 server name.  

6. Browse to the folder where the .mdf is located (Note: Ensure that the .mdf file is not read only). 
As well, prior to running this utility the ‘Users’ group for the folder in which the database files 
are stored must have full access permissions otherwise attaching of the database will fail. 

7. Press the ‘Execute Setup’ button. 
8. If you are using an additional copy of the database as a testing or training environment, it is 

recommended that a separate, appropriately named folder be created for this purpose. 
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Introduction to SQL 2005 Express 
 

Prior to installing any software, please ensure that you have made backup copies of your 
sensitive data.  Also please ensure that you have your backups readily available, and that you know the 
exact path to your databases.  MED2020 cannot be held responsible for data loss, nor can MED2020 
assist with data backup and recovery.  Instructions for backup and recovery are outside the scope of this 
document. 
 

Prior to installing Microsoft SQL Server 2005 Express Edition ensure that you have installed 
Microsoft .NET Framework 2.0. This can be downloaded from the Microsoft website at this location: 
http://msdn2.microsoft.com/en‐us/netframework/default.aspx 
Documentation, trouble shooting tips and knowledge base articles can be located on the Microsoft 
support website. The use of the information located in this document is specific to installing a Microsoft 
SQL Server 2005 Express Edition instance for use with a WinRecs database.    
 

Installation Procedures 
 

1. Download the installation package from this location on the Microsoft website: 
 
http://msdn2.microsoft.com/en‐us/express/bb410792.aspx 
 

2. Once you have downloaded the file launch the installation program SQLEXPR32.exe. After the 
files have been extracted you will be presented with the license agreement screen. Ensure to 
check the checkbox stating that you accept the terms and conditions and click next. 

 
3. Click to install the required pre‐requisites: 

• Microsoft SQL Native Client 
• Microsoft Server SQL 2005 Setup Support Files 

 
4. Once these files have been successfully installed click on next to proceed with the install. 

 

System Configuration Check 
 
The next step in the installation procedure is a System Configuration Check which ensures the computer 
is ready to have Microsoft SQL Server 2005 Express Edition installed. Once each of the fourteen checks 
has successfully run, click on Next and continue with the install. If any of the checks are not successful, 
exit out of the install and resolve the issues which the configuration check identified. Once the issues are 
fixed, restart the install.  
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1. At the ‘Feature Selection’ screen expand the ‘Client Components’ node and select the 
‘Connectivity Components’ option. 
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2. Click Next. 
3. At the ‘Instance Name’ choose the ‘Default instance’ radio button. 
4. Click Next.  

 

 

 

NOTE:  For WinRecs to function correctly, ensure that you choose default instance. 
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5. At the ‘Service Account’ screen choose the ‘Use the built-in System Account’ radio button. 
6. From the drop down list ensure that ‘Network Service’ is chosen 
7. Choose the ‘SQL Server’ and ‘SQL Browser’ check boxes. 
8. Click Next 

 

9. At the ‘Authentication Mode’ screen choose the ‘Mixed Mode’ radio button.  
10. Enter a password for the sa user. Note this password. 
11. Click Next 

 

 

NOTE:  WinRecs requires a Mixed Mode environment to function correctly. 
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12. At the ‘Collation Settings’ screen choose the ‘Collation designator and sort order’ radio 
button. 

13. From the drop down list choose ‘Latin1_General’ 
14. Ensure the ‘Accent – sensitive’ checkbox is checked and the other checkboxes are not 

checked. 
15. Click Next 

 

 

 

 

 

 

 

 

 

 

 

IMPORTANT NOTE:  It is imperative that Latin1_General is selected; do not use SQL 
Latin1_General, as performance will be severely degraded.  Accent Sensitive must be 
selected. 
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16. On the next screen ensure that the ‘Enable User Instances’ checkbox is checked and choose 
next. 
 

 

17. The next screen is the ‘Error and Usage Report Settings’ screen. Setting up these features is 
beyond the scope of this document. Refer to Microsoft documentation for information regarding 
using these options. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

18. On the ‘Ready to Install’ screen ensure that you have chosen the components you need to install 
and then proceed with the install. 

 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 44 of 105 

 
Friday, January 30, 2009 

 

19. Once the set up is complete click on the Next button. 
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Post Install 
 
After install is complete click on the Surface Area Configuration link on the final screen.  

 

 

1. When the Surface Area Configuration utility launches choose the Surface Area Configuration for 
Services and Connections link.  
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2. Expand the Database Engine Node 
3. Click on Remote Connections.  
4. Choose the ‘Using both TCP/IP and Named Pipes’ radio button. 
5. Apply your changes and exit out of the Surface Area Configuration Utility.  

 

 

6. Click Finish on the final install screen.  
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Installing SQL Server Management Studio Express 
 
Download the SQL Sever Management Studio Express msi file (SQLServer2005_SSMSEE.msi) from the 
following location: 
 
http://msdn2.microsoft.com/en‐us/express/bb410792.aspx 
 
Launch the file and choose all the defaults for installing the program. Click finish when the installation 
has completed. 
 
Windows Firewall Configuration 
 
In order for the WinRecs Client and SQL Server 2005 Express Edition to talk with one another they need 
to communicate over specific ports which need to be opened up within the Windows Firewall. 
 

1. From the control panel open up the Windows Firewall  
2. Choose the exceptions tab 
3. Create entries for the following ports – both TCP and UDP 

• 1433 
• 1434 
• 53 
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Attaching your WinRecs Database 
 

Attaching your WinRecs Database Using Medsql4.exe 
 

Med2020 will supply you with a utility which will attach your WinRecs database to Microsoft SQL Server 
2005 Express Edition for you. Utility name is Medsql4.exe.  medsql4.exe is located on our ftp server at 
ftp://web.med2020.ca.  In so doing all the security roles and permissions required will be configured for 
you.  

 

1. Create folder to hold the database. MED2020 recommends that the SQL2005 server installation 
is finished before the folder is created.  

2. Copy the WinRecs database to this folder.  
3. Launch Medsql4.exe. 
4. In the Environment box type in the name of the database as you want it to appear. 
5. Choose the (local) option in the server drop down box. If you select to use the named 

instance(see Page 8), the server name will have slash(like “<Local Computer Name>\<Server 
Name>”). If you can’t find the server name from the drop down list, you can type in the correct 
SQL2005 server name.  

6. Browse to the folder where the .mdf is located (Note: Ensure that the .mdf file is not read only). 
As well, prior to running this utility the ‘Users’ group for the folder in which the database files 
are stored must have full access permissions otherwise attaching of the database will fail. 

7. Press the ‘Execute Setup’ button. 
 

 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 49 of 105 

 
Friday, January 30, 2009 

Attaching the WinRecs Database Using Enterprise Manager 
 
 
Before proceeding with the following instructions, ensure that the WinRecs database file is available and 
has been extracted and copied to its permanent folder on the server.  Once a database has been 
attached, it cannot be moved until the database is detached at which time the system will be 
unavailable. More details on detaching and moving databases are provided later on in this document. 
The following instructions can only be used if the WinRecs database has been previously installed on the 
database server, as it relies on the MED2020Main user account.  For security reasons, the password for 
this account is not provided to customers.  Should it be necessary to attach the WinRecs database to a 
new server, attach the database using the MEDSQL4 utility, which creates the MED2020Main account  
In the examples to follow, the database file is MED2020_DATA.MDF and the database name is 
MED2020.  Open Enterprise Manager.  When Microsoft SQL Server 2000 is installed, a shortcut to 
Enterprise Manager is created in the Programs‐>Microsoft SQL Server folder, available from the 
Windows Start button.  In the Enterprise Manager tree view, clicking on the   icon expands the 
contents in the tree view.  Expand the contents as follows:  Console Root‐>Microsoft SQL Servers‐>SQL 
Server Group ‐>(local)‐> Databases Right‐click on Databases, and select All Tasks‐>Attach Database… 
 

 
The Attach Database dialog is displayed.  Click the browse button (ellipsis) to browse for the database 
file that will be attached 

 
 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 50 of 105 

 
Friday, January 30, 2009 

 

 
Locate the file in the Browse for Existing File dialog.  Highlight the file and click the OK button.  
 
The database and log files are now displayed.  Note the location of the transaction log is determined by 
the properties of the database server and cannot be changed in this dialog.  For more information on 
storing the transaction log on a different drive, consult the section entitled Moving a WinRecs 
Database, or attach the database using OSQL . 
Specify the WinRecs database parameters as follows: 
 

Attach as  Type WinRecs  

Specify database 
owner 

Select MED2020Main from the drop‐down list. This account 
is used by the WinRecs application and must not be 
changed. 
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Click the OK button to accept the settings; you will be notified if attaching the database is successful 
Click the OK button to acknowledge the message 

 

Once the database has been successfully attached, it is displayed in the tree view under Databases 
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Attaching Your WinRecs Database Using OSQL 
 
Before proceeding with the following instructions, ensure that the WinRecs database file is available and 
has been extracted and copied to its permanent folder on the server.  Once a database has been 
attached, it cannot be moved until the database is detached at which time the system will be 
unavailable. More details on detaching and moving databases are provided later on in this document. 
The following instructions can only be used if the WinRecs database has been previously installed on the 
database server, as it relies on the MED2020Main user account.  For security reasons, the password for 
this account is not provided to customers. 
Should it be necessary to attach the WinRecs database to a new server, attach the database using the 
MEDSQL2 utility, which creates the MED2020Main account  
In the examples to follow, the database file is MED2020_DATA.MDF, the database name is MED2020 
and the password is MED2020. 
 
 
 

Connect to the SQL server 
From a command line prompt on the server 

Click Start->Run  

Type cmd  

Press ENTER 
At the command line prompt, type  

osql –U sa –P MED2020 -S localhost 

If the connection is successful, the OSQL prompt will be displayed: 

1> 

Attach the WinRecs Database 
Attaching Without a Transaction Log File 
To attach a database using OSQL, the database name and path to the data file must be specified.   If you 
do not have a log file, use the following commands: 

1> EXEC sp_attach_db ‘MED2020’ @filename1=’<path/file to mdf file>’ 

2> go 

The command is successful if no error messages are returned.  The log file will automatically be created. 

Attaching With a Transaction Log File 
If you do have a log file, use the following commands: 

1> EXEC sp_attach_db ‘MED2020’ @filename1=’<path/file to mdf 
file>’,@filename2=’<path/file to ldf file>’ 

2> go 
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The command is successful if no error messages are returned. 

Changing the Database Owner 
For WinRecs to function correctly, the MED2020Main account must be specified as the database owner.  
This account is automatically created for you after using the medsql2 utility. 

To change the owner, use the following commands: 

1> use WinRecs 

2> exec sp_changedbowner MED2020Main 

3> go 

The command is successful if no error messages are returned. 

 

 
- The following parameters must be provided: 

Administrator Type sa 
Password Type the sa password.  
Environment Type a suitable name for your database.  For example, WinRecs 
Server Name Select (local) from the list 
Attach From Use the drop-down and list boxes to select the folder where the database files are located. 

- Click Execute Setup. Once the databases are attached successfully, Complete 
will be displayed in the lower-left corner of the MED2020 WinRecs Version 2.0 
Database Setup window. 

NOTE: If any errors are encountered while trying to attach the database, please contact MED2020 Client 
Services for assistance before continuing further. 
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Installing WinRecs 
Installing the WinRecs Application 
The following instructions are to be used when installing WinRecs on both the server and client 
workstations. 

• Install the latest version of WinRecs. This is available from the MED2020 Client FTP site at 
ftp://web.med2020.ca/WR2Update/.  Accept the default options. 

• When prompted, reboot the server/workstation. 

NOTE: Close all applications before installing WinRecs. 

  If, during the installation, errors relating to self-registration errors are received, make a note of the 
affected files and then click OK to continue with the WinRecs 2.0 installation. 

 It might be necessary to reboot the server and/or client workstations after the installation to 
ensure that the installed support files function correctly. 

 Ensure the Regional Settings on the server and workstations is mm/dd/yyyy 

Configuring WinRecs Reports 
• Download a list of available WinRecs reports from the MED2020 Client FTP site located at: 

ftp://web.med2020.ca/WR2Reports/WinRecs%20Pre‐Designed%20Report%20Library.xls.   
This file also contains important instructions pertaining to the Chart Deficiency and Chart 
Locator modules, as well as Batch Interfaces. 

• Identify the available reports and download them from the Client FTP site at: 
ftp://web.med2020.ca/WR2Reports. 

• Copy the downloaded reports to C:\Program Files\WinRecs2\Reporting on the WinRecs server 
(create this folder if it does not exist). 

• If you have purchased Business Object’s Crystal Reports software, please ensure that the 
software is installed on client workstations where reports will be created and modified.  This 
must be done prior to receiving on‐site training from MED2020 Health Care Software Inc. staff.   

NOTE: Crystal Reports is not required to run WinRecs reports. 

Testing the WinRecs Installation 
• Start WinRecs from the shortcut created on the desktop or by launching C:\Program 

Files\WinRecs2\WR_WinRecs.exe. 
• Log in to WinRecs using administrator credentials. 
 

The following credentials can be used for new installations: 
Username Admin 
Password Admin 
Server Specify the server name on which the database was installed 
Database Specify the database name selected when attaching the WinRecs database. 
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NOTE: For existing installations, the username and password parameters might have been 
changed from the system defaults.   

 

Installing and Updating the HL7 Interface 
 

1) Install WinRecs2HL7 on the WinRecs server. 
2) Run the Setup program and follow the instructions.  By default this will create a WinRecs2HL7 

folder under C:\Program Files.  Or click Browse if you wish to place the folder elsewhere.  The 
WinRecs2HL7.exe will reside in this folder.  To run the WinRecs2HL7.exe, click Start – Programs 
– WinRecs2HL7. 

3) The first time the WinRecs2HL7 is run, you must supply the following data: 
- Choose the proper WinRecs SQL Server. 
- Choose the proper WinRecs Database 1, i.e., use the TEST environment for testing. 
- Enter an unused Port Number higher than 2000. 
- Select Yes if Begin and End Block characters are used, otherwise select No. 

4) Click Test Connection. 
5) Click OK upon successful connection test.  Otherwise, repeat from Step 3. 
6) Click Save to save the settings. 
7) Click Continue. 
8) The WinRecs2HL7 should indicate Listening on the Status Bar (lower left corner). 
 

The Main screen: 

This screen displays every transaction that comes across from the ADT including errors and warnings of 
data.  This information is saved to the database and in a log file with filename WRHL7_yyyymmdd.LOG, 
e.g., WRHL7_20050101.LOG.  The log files reside in the folder C:\Program Files\WinRecs2HL7\LogData.  
They should be reviewed daily to ensure all HL7 Events and data elements are coming across properly.  
They also need to be deleted manually on a regular basis; otherwise, the LogData folder will occupy 
much memory. 

Stopping WinRecs HL7: 

1) Stop data transmission from the ADT. 
2) Click File – Exit. 

 

Changing the Configurations: 

1) Stop data transmission from the ADT. 
2) Click Option – Configuration. 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 56 of 105 

 
Friday, January 30, 2009 

3) Choose the proper WinRecs SQL Server. 
4) Choose the proper WinRecs Database. 
5) Enter an unused Port Number higher than 2000. 
6) Select Yes if Begin and End Block characters are used, otherwise No. 
7) If hospital purchased this option of printing reports, otherwise leave blank: 

• Click Add to add a list of destination printers and number of copies until all printers are 
included. 

8) Click Test Connection.  If errors, repeat Step 3 to Step 7 and ensure all data are correct. 
9) Click Save to keep the changes. 
10) Click Continue. 
11) The WinRecs2HL7 should be in Listen mode. 
12) Start data transmission from ADT. 

 

Changing Font: 

1) Click Edit – Font. 
2) Choose Font. 
3) Click OK. 
4) The selected Font will be applied starting with the next transaction. 
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Running HL7 as a Service 
 

IMPORTANT: This article contains information about editing the registry. Before you edit the registry, make 
sure you understand how to restore it if a problem occurs. For information on how to do this, view the 
"Restoring the Registry" or the "Restoring a Registry Key" online Help topics in Registry Editor.  

 

The Windows NT Resource Kit provides two utilities that allow you to create a Windows NT user-defined 

service for Windows NT applications and some 16-bit applications (but not for batch files).  

 

Instrsrv.exe installs and removes system services from Windows NT and Srvany.exe allows any Windows NT 

application to run as a service.  

To create a Windows NT user-defined service, perform the following steps:  

1. At a MS-DOS command prompt(running CMD.EXE), type the following command: 

 

path\INSTSRV.EXE My Service path\SRVANY.EXE 

 

where path is the drive and directory of the Windows NT Resource Kit (i.e., C:\RESKIT) and My 

Service is the name of the service you are creating. 

 

Example:  

C:\Program Files\Windows Resource Kits\Tools\Instsrv.exe Winrecs2Hl7 C:\Program 

Files\Windows Resource Kits\Tools\Srvany.exe 

NOTE: To verify that the service was created correctly, check the registry to verify that the 

ImagePath value under  

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\service name 

is set to point to SRVANY.EXE. If this is not set correctly, the service will stop shortly after it 

starts and return an Event ID 7000 "The service name failed to start."  

 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 58 of 105 

 
Friday, January 30, 2009 

WARNING: Using Registry Editor incorrectly can cause serious problems that may require you 

to reinstall your operating system. Microsoft cannot guarantee that problems resulting from the 

incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. 

 

For information about how to edit the registry, view the "Changing Keys And Values" online Help 

topic or the "Add and Delete Information in the Registry" and "Edit Registry Data" online Help 

topics in Registry Editor. 

 

NOTE: You should back up the registry before you edit it.  

2. Run Registry Editor (Regedt32.exe)and locate the following subkey: 

 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\<My Service>  

3. From the Edit menu, click Add Key. Type the following and click OK: 

 

Key Name: Parameters 

Class : <leave blank>  

4. Select the Parameters key.  

5. From the Edit menu, click Add Value. Type the following and click OK: 

 

Value Name: Application 

Data Type : REG_SZ 

String : <path>\<application.ext> 

 

where <path>\<application.ext> is the drive and full path to the application executable 

including the extension (i.e., C:\Program Files\WinRecsHL7\WinRecs2HL7.exe)  

6. Close Registry Editor. 

By default, a newly created service it configured to run Automatically when the system is restarted. To 

change this setting to Manual, run the Services applet from Control Panel and change the Startup value to 

Manual. A service set to Manual can be started in one of several ways:  

- From the Services applet in Control Panel  
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- From a MS-DOS command prompt, type the following:  

 

NET START <My Service>  

 

- Use the Sc.exe utility from the Resource Kit. Type the following from a MS-DOS command prompt:  

 

<path>\Sc.exe start <My Service>  

 

where <path> is the drive and directory of the Windows NT Resource Kit (i.e., C:\Reskit).  

 

 

For more information on installing and removing a user-defined service, please see the Srvany.wri document 

provided with the Windows NT Resource Kit utilities (i.e., C:\Reskit\Srvany.wri). This document can also 

be found on the Windows NT Resource Kit CD in the Common\Config directory.  

 

APPLIES TO 

• Microsoft Windows 2000 Server  

• Microsoft Windows 2000 Advanced Server  

• Microsoft Windows 2000 Professional Edition  

• Microsoft Windows NT Workstation 3.51  

• Microsoft Windows NT Workstation 4.0 Developer Edition  

• Microsoft Windows NT Server 3.51  

• Microsoft Windows NT Server 4.0 Standard Edition 

•  

Download SrvAny from Microsoft as part of the Windows Server Resource Toolkit (12 
MB).SrvAny and its installer "InstSrv" are applications provided by Microsoft. SrvAny allows 
Windows applications to run as a service.  

Easily adapted instructions are included with the program in the file SRVANY.WRI  

This is how it looks in the registry after you run the SrvAny installer 
command line: 
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“C:\Program Files\Windows Resource Kits\Tools\Instsrv.exe” Winrecs2Hl7 “C:\Program 

Files\Windows Resource Kits\Tools\Srvany.exe” 

 

 

 

Now you need to add a "Parameter" key with a value called "Application". It contains the 
path to your executable. For example, this can be the application that uses the  
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Attaching the Batch In Database 
Using Enterprise Manager 
Attach the Batch In database the same was as attaching the WinRecs database, except for the files and 
file names to be used.  Refer to the process outlined in the Using Enterprise Manager section of 
Attaching the WinRecs Database. During the process, be sure to attach the Batch In database files and 
not the WinRecs database files. 

Using OSQL 
Attach the Batch In database the same was as attaching the WinRecs database, except for the files and 
file names to be used.  Refer to the process outlined in the Using OSQL section of Attaching the 
WinRecs Database, During the process, be sure to attach the Batch In database files and not the 
WinRecs database files. 

Using the BIClient Utility 
The Batch In Interface uses a separate database, which must be attached to the WinRecs database 
server before the Batch In module can be configured and used.  MED2020 supplies a custom utility to 
assist with attaching the database. 

Before proceeding, a copy of the BIClient.exe utility and CV_WRImport_Data.mdf files are required.  
These are supplied to you by MED2020.  Contact MED2020 Client Services for more assistance in 
acquiring these files.  

• Run BIClient.exe on the server 
• Click the elipsis to browse for the database file to be attached 
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• Once selected, click Open 
• Click Next 

 
 

• Select the folder to where the database will be copied.  Click on the elipsis to browse for 
the file.  Once selected, click Next  
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• Type the name for the database and click Next  

 
 

• Click OK to acknowledge that the database was successfully attached. 

   

Troubleshooting 

• If the BI database is already attached, the following error is displayed: 
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• If the database file has already been attached and you want to copy to another location, 
there will be errors. Once a database file is attached, standard file operations cannot be 
performed.  

 
Configuring the Batch In Interface 
Selecting the Batch In Database 
WinRecs must be configured before the Batch Interface can be used, 

• Launch WinRecs and log in using an administrator account 
• Open Utilities->Incoming Batch Interface from the WinRecs Application Menu or the 

Modules menu.  When this is first run, an error will be displayed. 
• Click OK to acknowledge the error. 
• In the WinRecs Batch Interface window, select Settings from the Tools menu 
• From the drop-down list, select the Batch In database that was previously attached and 

click OK 

NOTE: Before the BI Interface can be used, the BI configuration screen must be closed and 
reopened after the initial configuration and when the settings are changed. 

Checking Date Range Conflicts 
Before running the Batch In interface, it is also recommended that the system be checked for date range 
conflicts. 

NOTE: The BI Date Range Errors.rpt must exist in the WinRecs reporting folder (C:\Program 
Files\WinRecs2\reporting) 

• In the WinRecs Batch Interface window, select Date Range Conflicts from the Tools 
menu 

WinRecs will check for date range conflicts and display a Crystal Report.  If conflicts exist, proceed to 
Lookup Maintenance to clean up the tables where conflicts exist. 

NOTE: The report is specific to the Incoming Batch Interface, and does not apply to the NACRS 
10 Error Import function. 
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Server Maintenance 
Re-Indexing the Database 
 
Purpose:  This document will provide step‐by‐step instruction on how to set up a re‐indexing job on your 
WinRecs client server.  

IMPORTANT NOTE:  Currently it is not possible to Re-Index a database without SQL 
Management Studio or Enterprise Manager.  For sites still using SQL 2000 MSDE, it is a 
good idea to consider upgrading to SQL 2005 Express, which properly supports this 
functionality. 

 

Re‐indexing the WinRecs database is recommended on a periodic basis, with the following guidelines: 

 

 

   

 

Regular re‐indexing will greatly assist in the performance of the SQL database. 

Step 1 

Click Start   All Programs  Microsoft SQL Server  Enterprise Manager 

 

Databases < 5 GB in size  Re‐index once per week 

Databases 5 – 10 GB in size  Re‐index twice per week 

Databases > 10 GB in size  Re‐index every other day 
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Step 2 

From the SQL Server Group, identify the server you want to set the job on.   

Click + sign beside server name to expand list 

 

Step 3 

Select the Management option. 

Click + sign beside Management to expand list. 

If the SQL Server Agent is not running it will have a red square in a white circle 

  

3.1 

To start the SQL Server Agent, right‐click SQL Server Agent and select ‘Start’ 
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3.2 

  Your SQL Server Agent will now look like this 

 

 

Step 4 

Now that your SQL Server Agent is running, 

 

Click the + sign beside SQL Server Agent to expand list to show Agent options 
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Step 5 

Double‐click Jobs to display all the jobs on the right that are currently setup. 

 

Step 6 

Highlight Jobs, then right‐click and from the menu select New Job 

 

Step 7 

  A New Job Properties Window is displayed with the General tab selected 
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Step 8 

8.1  Name the new Job.  In this example, we call it “Re‐Index”. 

8.2 For the Category, select Database Maintenance 

8.3 Ensure Owner is set to MED2020Main 

 

Step 9 
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  Select the Steps tab to open this view. 

 

9.1  Click ‘New’ button to open up the New Job Step window 

 

9.2  Change the Step name, Type and Database 

In the example below, the step has been named ‘Re‐IndexStep’; Type must be Transact‐SQL Script 
(TSQL), and the Database can be chosen for the specific db you want this job to apply to. 
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9.3  Enter Command line 

In the Command window, enter the following text exactly: 

exec M_NewIndexFind 

GO 

exec M_IndexCleanupNew 

GO 
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9.4 Click the Parse button to check the syntax.   

If syntax is correct, the ‘Parse Succeeded’ window will display.  If syntax is incorrect, you will see a 
syntax error message and the command must be corrected before proceeding. 

 

 
   

 

 

9.5  Click Advanced tab in the New Job Step window 
 
Ensure that “Run as user:” is set to “(Self)” 
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9.6  Click Apply button and then OK to go back to the New Job Properties main screen 

 

Step 10 
  Click Schedules tab, then click New Schedule. 
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10.1 Name the schedule based on your organization’s naming conventions 

10.2 Select the scheduling option you prefer  

10.3 Refer to the recommended frequencies grid in the Purpose section of this document to 
determine the frequency with which the job should be executed. 
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10.4 Once your scheduling option is entered, click OK to return to the New Job Properties 
window 

 

Step 11 
  If you wish to set up notification for the job, select the Notifications tab.  
 

 

11.1  By default, the job writes to the Windows application event log.  Additional options are available 
but fall outside of the scope of this document.   
11.2  Click General tab and click Apply button to add this job.  Click OK to leave the New Job 
Properties window. 
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Step 12 

You should now see a new job called Re‐Index 
 

 

Highlight the Re‐Index job and right‐click for options, or double‐click to open up Job setting window. 
 
You can select Start Job at any time to initiate the re‐indexing of your database immediately. 
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WinRecs Maintenance 
Patches, updates and service releases are intermittently made available to WinRecs customers to resolve 
critical issues, implement enhancements to the application or update important edits, such as those 
supplied by the Canadian Institute for Health Information (CIHI).  While MED2020 attempts to minimize 
the number, frequency and complexity of these updates, it is necessary to ensure WinRecs functions 
within the required parameters as mandated by provincial and federal regulations 

Additionally, while MED2020 strives to ensure that all updates are problem-free, certain difficulties might 
be encountered during the update process.  

WRU Updates 
WinRecs patches, supplied as WRU files, run SQL scripts to update database stored procedures and/or 
tables and tables. To install MED2020-supplied database patches:  

- Log in to WinRecs  

- Select Database Update History from the Modules->System Maintenance menu  

 
- Click Run Database Update at the bottom-right of the screen 

 
- Search for the patch (.wru) file and once selected, click Open 
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The patch information will be displayed. 

- Click Run Database Update to begin the installation 

 
The progress bar will display the status of the installation.  Once completed, Update Finished is displayed 
in the status bar. 

- Click the Windows close control (X) at the top right to exit from the smaller screen 

 
- WinRecs must be restarted after running an update 
- Click OK to close WinRecs 
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Changes to the database have been applied.   The WinRecs client will be updated (if applicable) during 
the next login. 

EXE Updates 
WinRecs hot fixes, and cumulative and service releases differ from database patches in the following 
ways: 

The updates are installed outside of WinRecs, 
The updates apply application updates to the WinRecs installation. 

IMPORTANT NOTE: Do not make any attempt to install this type of update to a workstation.  This 
update is a server-side update and must be done only on the database server. 

As with database patches, it is only necessary to install these once.  Application updates are 
automatically applied to the WinRecs client workstations when users log in. 

Extract the archive contents (executable and bin folder) to a temporary location, using the preferred 
unzip utility (such as WinZip).  

Run the executable 

NOTE: Do not move or remove the contents of the archive once they have been extracted.  

Specify the database server and database using the drop-down boxes and then click Update. 

 
The progress bar displays the status of the update in two stages: 

i. The first displays the status of database updates 
ii. The second status bar displays the status of application update. 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 81 of 105 

 
Friday, January 30, 2009 

Once finished, click Exit to close the update program. 

 

Service Releases 
WinRecs upgrades often contain previous cumulative releases and hot-fixes for the current version and 
are supplied as compressed archive (zip) files. It is important to read the release notes, as they will tell 
you if there are any prerequisites to the service release.  Upgrades must be applied locally on the 
database server from the local hard disk to ensure that network interruptions do not interfere with the 
process.   

Before continuing, ensure that: 
All WinRecs users are logged out; 
If an HL7 interface is installed, that all transactions are paused and the HL7 application is shut down; 
The sa password for the SQL database is known; 
A full, recent backup of the WinRecs database is available. 

Installing the Update 
Obtain the WinRecs update from the MED2020 Support site at ftp://web.med2020.ca. 
Extract the archive contents to a temporary folder on the WinRecs database server. 

The wrupdate application and an install directory will be created. 

 
If either of these files is missing, do not proceed with the installation and contact MED2020 Client 
Services for more assistance. 

NOTE: Do not alter the files or file structure after extracting the aforementioned files and folders. 

Run the wrupdate application to begin the upgrade process. 
Click Next 
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Click on the elipsis to select the Server Name  
Select the database server from the list and click OK 
Click Next 

 

NOTE: In certain situations, the installer might require the password for the SQL sa account.  Supply the 
password as required.  If the password is unknown, do not attempt to proceed with the 
installation. 

Select the Database Name from the drop-down list 
Click Next 
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Click Yes to accept the Software License Agreement 

 
Click Next to confirm the update installation 

NOTE: The installation cannot be cancelled after this step 
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A series of dialog boxes will be displayed to confirm the status of the upgrade: 

 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 85 of 105 

 
Friday, January 30, 2009 

 

NOTE: During the upgrade, the installation may be unresponsive.  This is normal. 

Once completed, click Close to finish the installation 

 

Troubleshooting 
Database Errors 
During the installation process, the dbresults.xml error log file is automatically created in the folder 
where the wrupdate application is located.  

 
This file will always be created, and does not imply that errors were encountered. 

Should there be errors during the installation, the following screen will be displayed: 
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If this occurs, do not use WinRecs without first consulting MED2020 Client Services, who will require a 
copy of the dbresults.xml file. 

Missing Files or Folders 
If required files or folders are missing when installing the update, a Critical Error Occurred dialog, similar 
to the following, will be displayed: 

 

Re-running the Update 
The following dialog will be displayed if the update has already been installed: 
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It is not recommended to reinstall the update without having previously consulted with MED2020 Client 
Services. 
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Server Maintenance 
Using the Security Change Utility 
The following utility can be used to test the availability of the database server, and correct the 
authentication model in the event the database server was not configured, at installation time, to use 
Mixed-mode (both Windows and SQL) authentication. 

 
To make changes to the authentication method of the SQL Server installation, complete the fields in the 
Security Change utility as follows: 

To test using the SQL Server administrator account 
Uncheck Windows Authentication 
In the first text box, type the SQL administrator account (typically sa) 
In the second text box, type the password to the administrator account provided above 
Click Test Connection 

To test using the Windows administrator account 
Select Windows Authentication 
In the first text box, type the account name of a user with local administrator priviledges.  For domain 

accounts, type the domain\username. 
In the second text box, type the password to the administrator account provided above 
Click Test Connection 

A notification dialog will be displayed to confirm if a connection was successfully made. 

To change the authentication mode 
Select Windows or SQL Server Authentication 
Click Change Authentication Mode 
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Starting and Stopping SQL Server 
Using SQL Service Manager  
The Service Manager utility (installed by default to C:\Program Files\Microsoft SQL 
Server\MSSQL\BINN\sqlagent.exe) is used to visually identify the status of the SQL Server.  After 
installing SQL Server, a shortcut should be in the Start Up folder (Start->Programs->Startup), which 
launches this utility every time the server is restarted.   

When running, the Service Manager icon is displayed in the tray: 

.  

This utility can be used to control the state of the SQL server.   
Double-click on the icon in the task bar to open the SQL Server Service Manager window 

Be sure the correct server and service (SQL Server) are selected in the respective drop-down lists 
Click the Start/Continue, or Stop buttons to start and stop the SQL Server, accordingly 

 

NOTE: Do not stop the service while client workstations or HL7 interface applications are running. 

Using Services (Administrative Tools) 
Open the Windows Services shortcut: Start->Settings->Control Panel->Administrative Tools-

>Services 
Locate MSSQLSERVER in the services list. The status is displayed in the Status column.   
To start or stop the SQL Server service, double-click the entry and click the Start or Stop button, 

accordingly. 

NOTE: Do not stop the service while client workstations or HL7 interface applications are running. 

Detaching the WinRecs Database 
The following steps are used to successfully detach the WinRecs database. 

NOTE: All WinRecs users in your facility must not be using the WinRecs application when these steps 
are performed.  Otherwise, data might be lost. 
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Using Enterprise Manager 
Before detaching the database, verify the location of the data file that will be used in the post-detach 
activities:  
 

 
Right-click on the database and select Properties 
Click the Data tab 

 
Right-click on the database and select All Tasks->Detatch Database… 
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Click OK to detach the database. The WinRecs database has been attached and is no longer 

displayed in the tree view. 

The Database Status section of the Detach Database window identifies if users are still connected to the 
WinRecs server: 
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Click the Clear button 
Click the OK button 

 

 

 
Click OK to detach the database. The WinRecs database has been attached and is no longer 

displayed in the tree view. 
 

Using OSQL 
Connect to the MSDE server 
From a command line prompt on the server 

Click Start->Run  

Type cmd  
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Press ENTER 

At the command line prompt, type  

osql –U sa –P MED2020 -S localhost 

If the connection is successful, the OSQL prompt will be displayed: 

1> 

Detach the WinRecs Database 
The database must be detached before a copy can be made and sent to MED2020 Client Services for 
troubleshooting. 

1> EXEC sp_detach_db ‘MED2020’ 

2> go 

The command is successful if no error messages are returned. 

Using the MEDSQL2 Utility 
Download medsql2.exe from the MED2020 client support site at ftp://web.med2020.ca to the server. 

Run medsql2.exe 
Complete the fields as follows: 

Administrator Type sa 
Password Type the password for the SQL sa account 
Environment Type the name of the database as it is to be attached 
Server Name Select the database server from the drop-down list. 
Attach From Ensure that the folder selected is where the LDF and MDF files are located. 

 

 
Click Detach. 

Moving the Transaction Log to a different drive 
The size and growth of the transaction log can often impede the availability and performance of the 
WinRecs database. In such situations, it is recommended to move the transaction log to a different 
physical location. 
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• Identify the location and physical file name of the transaction log. 
• Detach the database. 
• Relocate the transaction log (ldf) file to the new location 
• Begin the process to attach the database file as previously instructed. 
• In Enterprise Manager, reattach the database.  

The Attach Database window will reflect that the log file cannot be found 

 
• Click the file location entry in the window and type in the correct path and file name 
• Click on the red X 
• The Current File Location for the transaction log should now be registered correctly. 

Complete the remaining steps to attach the database. 

Advanced Database Management 
The following sections details steps that might assist facilities when the WinRecs database is low on disk 
space. 

Shrinking The Log File 
Using Enterprise Manager 

From within Enterprise Manager, expand the following sections in the tree view to reveal the WinRecs 
database in the list:  
Microsoft SQL Servers->SQL Server Group->(local)->Databases 

Navigate to the WinRecs database. 
Right-click on the database and select All Tasks->Shrink Database… 
Click the Files button 
In the Database file drop-down list, select the log file 
Select Compress pages and then truncate free space from the file 
Uncheck AutoShrink 
Click OK 

Using OSQL 
Connect to the MSDE server 

From a command line prompt on the server 

Click Start->Run  
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type cmd  

Press ENTER 
At the command line prompt, type  

osql –U sa –P MED2020 -S localhost 

If the connection is successful, the osql prompt will be displayed: 

1> 

Identify the log file name 
1> use tempdb 

2> go 

The command is successful if no error messages are returned. 

1> sp_helpfile 

2> go 

The command is successful if no error messages are returned and  

The name column will display the logical name for the transaction logs.  In the example above, the logical 
name for the tempdb database is templog. 

To backup the log file 
1> backup log tempdb with truncate_only 

2> go 

The command is successful if no error messages are returned. 

To shrink the log file 
1> dbcc shrinkfile('templog’,truncateonly) 

2> go 

The command is successful if no error messages are returned. 

Setting Recovery Model 
The recovery model determines to what extent databases can be recovered in the event of failure.  By 
default, all SQL databases are configured with a Full recovery model. 

For customers who are consistently running out of disk space and cannot relocate the transaction log to 
an alternate drive, the recovery model can be changed to Simple which will reduce the amount of disk 
space that the transaction logs will consume. 

Using Enterprise Manager 
From within Enterprise Manager, expand the following sections in the tree view to reveal the WinRecs 

database in the list:  
Microsoft SQL Servers->SQL Server Group->(local)->Databases 

Navigate to the WinRecs database. 
Right-click on the database and select Properties 
Click the Options tab 
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In the Recovery: Model drop-down list, select the recovery model.  The following table can be used to 
determine the most appropriate method: 

Bulk-Logged The BULK_LOGGED recovery model has fewer recovery options than the FULL 
model, but it doesn't have as severe a performance hit on bulk operations. It uses 
less log space on certain bulk operations because it records only the operations' 
results. With this model, however, you can't restore to a specific mark in the 
database, nor can you restore just parts of the database. 

Full The FULL recovery model gives you the most recovery flexibility. It's the default 
recovery option for new databases. This model allows you to restore just part of a 
database or do a complete recovery. Assuming the transactions logs haven't been 
damaged, you can also recover up to the last committed transaction prior to a failure. 
This method uses the most transaction log space of all the recovery models and it 
causes a slight hit to SQL Server performance. 

Simple The SIMPLE recovery model is the easiest of the three to implement and it uses the 
least amount of storage space. However, recovery is limited to when the database 
was last backed up. 

Once the recovery model has been selected, click OK. 

Using OSQL 
Connect to the MSDE server 

From a command line prompt on the server 

Click Start->Run  

type cmd  

Press ENTER 
At the command line prompt, type : 

osql –U sa –P MED2020 -S localhost 

If the connection is successful, the osql prompt will be displayed: 

1> 

To change the recovery model to simple for the WinRecs database 
1> ALTER DATABASE WINRECS SET RECOVERY SIMPLE  

2> go 

The command is successful if no error messages are returned. 

 

Sizing the Database 
Properly sizing the database avoids the additional overhead associated with growing data files. Limiting 
the amount of physical database growth will help prevent the fragmentation of data files,.  

As a baseline, it is recommended to set the data file to either 25% larger than the actual storage 
requirements, or to 40 MB. 
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Backing up the Databases 
It is recommended to use SQL Server to backup databases as the data files are locked when attached.  
Only select tools are able to back up open data files.  Additionally, SQL Server faster at creating database 
backups than other software solutions. 

This method also ensures that, in the event of a network backup failure, a local backup is available. 

Creating a Maintenance Plan in Enterprise Manager 
In Enterprise Manager expand the tree to the Management options:  

Microsoft SQL Servers->SQL Server Group->(local)->Management 
Right-click on Database Maintenance plans and select New Maintenance Plan… 
Click Next 
Select the database(s) for which to create the maintenance plan: 

 
Click Next 
Select Reorganize data and index pages 
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NOTE: When used weekly, your tables will run at optimum efficiency. 

Click Next 
Select Check database integrity 

 
Click Next 
Select Backup and verify 
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When the maintenance plan is run, the data file will be backed up to disk.  
Click Next 
Specify the folder to which the backup file will be written. 
Specify other backup options as might be required. 

 

 
Click Next 
Select Back up the transaction log as part of the maintenance plan 
Select Verify the integrity of the backup when complete 



    WinRecs Server Installation & Maintenance Guide 

   
   

Page 100 of 105 

 
Friday, January 30, 2009 

 
Click Next 
Identify if an activity report will be created 

 
Click Next 
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 Click Finish to close the maintenance plan wizard. 

 
The maintenance plan is now displayed in the Management->Database Maintenance Plans folder of 
Enterprise Manager 

 

NOTE: Be sure to verify the maintenance jobs by running them at least once prior to establishing a 
routine schedule as part of your recovery process. 
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Using OSQL 
The following script can be used as a guideline to perform a backup of the WinRecs database using 
OSQL: 

osql -S localhost –U sa –P password -Q " BACKUP DATABASE WINRECS TO DISK 
= ' c:\backups\winrecs_db.bak' ' " 

Substitute the italicized values above with those relevant to your particular MSDE installation, according 
to the guidelines provided below: 

localhost Database server (localhost = this server) 

sa SQL user with backup privileges 

password Password for the sa account 

WINRECS Name of the WinRecs database 

c:\backups\winrecs_db.bak Path and file name of the backup file to be written  

Restoring a Database Backup 
During the restore, the specified database must not be in use. Any data in the specified database is 
replaced by the restored data. 

Using Enterprise Manager 

Using OSQL 
The following script can be used as a guideline to perform a full restore from backup using OSQL: 

osql -S localhost –U sa –P password -Q " RESTORE DATABASE WINRECS FROM 
DISK = ' c:\backups\winrecs_db.bak ' " 

Substitute the italicized values above with those relevant to your particular MSDE installation, 
according to the guidelines provided below: 

localhost Database server (localhost = this server) 

sa SQL user with backup privileges 

password Password for the sa account 

WINRECS Name of the WinRecs database 

c:\backups\winrecs_db.bak Path and file name of the backup file to be restored  

NOTE: Using this command will overwrite all existing data. 

  For information on how to perform partial restores, consult the Microsoft support site. 

Shutting Down the WinRecs Server 
It is recommended that the following steps be performed to successfully shutdown the WinRecs server.  

Note that the users in your facility must not be using WinRecs when these steps are performed.  
Otherwise, data might be lost. 
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• Advised all WinRecs client workstations to disconnect and discontinue use of the WinRecs 
system until the maintenance is complete. 

• If an HL7 interface is installed: 

o Stop the ADT interface that feeds messages to the WinRecs HL7 interface. 

o Stop the WinRecs HL7 interface  

• It is now safe to shut down the WinRecs Server, or perform other system maintenance tasks. 

Relocating/Cloning WinRecs to Another Server 
• Prepare the current server by performing the steps in the section entitled Shutting Down 

WinRecs.  Do not reboot the server. 
• Detach the WinRecs and/or Batch-In database(s) that will be moved to a new folder, drive or 

server.  
• Archive (create a zip file of) the Database (.mdf) and Transaction Log (.ldf) files.  

NOTE:  Do not change the file names of the Database or Transaction Log files. 

• Archive, copy and relocate the WR2 Reports folder and/or any shared reports folders used by 
WinRecs client workstations. 

• Proceed with the installation of the new server as usual. 
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WinRecs Installation Check List

 

 

 

 

 

 

Server Configuration 

Server Name: 

Server IP: 

Total Memory: 

Disk Space: 

WinRecs 

WinRecs Version: 

CD‐Key: 

WinRecs Installation Folder: 

Shared Reports folder(s):

HL7     Version:    TCP Port: 

Batch‐In    Version: 

Batch‐Out    Version: 

Database         

Server Name:  sa password:

SQL Software/Version:  Recovery Mode:

Data Path/File:  Memory Allocated:

Log Path/File: 

Total space available on disk/SAN volume: 

Software Configuration 

Operating System:

SQL Version:

Crystal Reports    Version: 

 

Notes 


